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M System Requirements

e “Related Documentation” section on page 35

e “Obtaining Technical Assistance” section on page 37

System Requirements

This section describes these system requirements for IOS Release 12.1(6)EA2a:
e “Hardware Supported” section on page 2
e “Hardware Not Supported” section on page 3

e “Hardware and Software Requirements for the Cluster Management Suite” section on page 3

Hardware Supported

Table 1 lists the hardware supported by this IOS release.

Table 1 Hardware Supported

Hardware Description

Catalyst 2950C-24 24 fixed autosensing 10/100 Ethernet ports and
2 100BASE-FX ports

Catalyst 2950T-24 24 fixed autosensing 10/100 ports and
2 fixed autosensing 10/100/1000 Ethernet ports'

Catalyst 2950G-12-EI 12 fixed autosensing 10/100 Ethernet ports and 2 GBIC?-based
Gigabit Ethernet module slots

Catalyst 2950G-24-EI 24 fixed autosensing 10/100 Ethernet ports and 2 GBIC-based Gigabit
Ethernet module slots

Catalyst 2950G-48-EI 48 fixed autosensing 10/100 Ethernet ports and 2 GBIC-based Gigabit

Ethernet module slots

Catalyst 2950G-24-EI-DC 24 fixed autosensing 10/100 Ethernet ports and 2 GBIC-based Gigabit
Ethernet module slots with DC-input power

GBIC Modules e 1000BASE-SX GBIC

e 1000BASE-LX/LH GBIC
e 1000BASE-ZX GBIC

e GigaStack GBIC

Redundant power system Cisco RPS 300 Redundant Power System

1. When the 10/100/1000 ports are set to 10 or 100 Mbps, they can operate in either half- or full-duplex mode, but when they
are set to 1000 Mbps, they can operate only in full-duplex mode.

2. GBIC=Gigabit Interface Converter

System Requirements
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Hardware Not Supported

Table 2 lists the hardware not supported by Cisco IOS Release 12.1(6)EA2a.

Table 2 Hardware Not Supported

System Requirements W

Hardware

Description

Catalyst 2950-12

12 fixed autosensing 10/100 Ethernet ports

Catalyst 2950-24

24 fixed autosensing 10/100 Ethernet ports

GBIC Module

1000BASE-T GBIC (part number WS-G4582)

Redundant power system

Cisco RPS 600 Redundant Power System

Hardware and Software Requirements for the Cluster Management Suite

The minimum PC requirement is a Pentium processor running at 233 MHz with 64 MB of DRAM. The
minimum UNIX workstation requirement is a Sun Ultra 1 running at 143 MHz with 64 MB of DRAM.

Table 3 lists the recommended platforms.

These operating systems are supported for web-based management:

Microsoft Windows 2000

Microsoft Windows 95 (Service Pack 1 required)

Microsoft Windows 98, second edition

Microsoft Windows NT 4.0 (Service Pack 3 or higher required)

Solaris 2.5.1 or higher, with the Sun-recommended patch cluster for that operating system and Motif

library patch 103461-24

Table 3 Recommended Platform Configuration for Web-Based Management

0s Processor Speed DRAM Number of Colors Resolution |Font Size
Windows |Pentium 300 MHz 128 MB |65536 1024 x 768 |Small
NT 4.0

Solaris Sparc 333 MHz 128 MB |Most colors for — Small (3)

2.5.1

applications

1.

Browser Support

Service Pack 3 or higher required

You can access the web-based interfaces through the browsers listed in Table 4, which also lists the
configuration that yields the best results for web-based management. The switch checks the browser
version when starting a session to ensure that the browser is supported. If the browser is not supported,
the switch displays an error message, and the session does not start.

| oL-1644-02
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Note

Table 4 Browser Support for Web-Based Management

Browser Minimum Version Supported Versions
Netscape Communicator |4.61' 4.61, 4.7x
Internet Explorer2 4.01a 4.01a, 5.0, 5.5 (Service Pack 1 or higher)

1. Netscape Communicator 4.6 and 6.0 are not supported.

2. Not supported on Solaris 2.5.1 or higher.

In Cluster Management displays, Internet Explorer versions 4.01 and 5.0 might not display edge devices
that are not connected to the command switch. Other functionality is similar to that of Netscape
Communicator.

Installing the Required Plug-In

Note

Note

A Java plug-in is required for the browser to access the Java-based Cluster Management Suite (CMS).
Download and install the plug-in before you start CMS. Each platform, Windows and Solaris, supports
three plug-in versions. For information on the supported plug-ins, see the “Windows 2000, Windows 95,
Windows 98, and Windows NT 4.0 Platforms” section on page 5 and the “Solaris Platforms” section on
page 5.

You can download the recommended plug-ins from this URL:
http://www.cisco.com/pcgi-bin/tablebuild.pl/java

Uninstall older versions of the Java plug-ins before installing the Java plug-in.

If the Java applet does not initialize after you have installed the plug-in, open the Java Plug-in Control
Panel (Start > Programs > Java Plug-in Control Panel), and verify these settings:

In the Proxies tab, verify that the Use browser settings is checked and that no proxies are enabled.

If you are running McAfee VirusScan on Windows 2000 and the plug-in takes a long time to load, you
can speed up CMS operation by disabling the VirusScan Internet Filter option, the Download Scan
option, or both.

From the Start menu, disable the options by selecting Start > Programs > Network Associates > Virus
Scan Console > Configure.

or

From the taskbar, right-click the Virus Shield icon, and in the Quick Enable menu, disable the options
by deselecting Internet Filter or Download Scan.

Hardware and Software Requirements for the Cluster Management Suite
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Windows 2000, Windows 95, Windows 98, and Windows NT 4.0 Platforms

Note

Solaris Platforms

A

These Java plug-ins are supported on the Windows platform:
e Java plug-in 1.3.1
e Java plug-in 1.3.0
e Java plug-in 1.2.2_05
You can download these plug-ins from this URL:
http://www.cisco.com/pcgi-bin/tablebuild.pl/java

If you start CMS without having installed the required Java plug-in, the browser automatically detects
this. If you are using a supported Internet Explorer browser, it automatically downloads and installs the
Java plug-in 1.3.0 (default). If you are using a supported Netscape browser, the browser displays a
Cisco.com page that contains the Java plug-in and installation instructions. If you are using Windows
2000, Netscape Communicator might not detect the missing Java plug-in.

These Java plug-ins are supported on the Solaris platform:

Caution

To avoid performance and compatibility issues, do not use Java plug-ins later than Java plug-in 1.3.1.

e Java plug-in 1.2.2_07
e Java plug-in 1.3.0
e Java plug-in 1.3.1
You can download these plug-ins and instructions from this URL:
http://www.cisco.com/pcgi-bin/tablebuild.pl/java
To install the Java plug-in, follow the instructions in the README_FIRST.txt file.

Creating Clusters with Different Releases of 10S Software

When a cluster consists of Catalyst 3550 switches and a mixture of other Catalyst switches, we strongly
recommend using only the Catalyst 3550 switches as the command and standby command switches.
When the command switch is a Catalyst 3550 switch, all standby command switches must also be
Catalyst 3550 switches. The Catalyst 3550 switch that has the latest software should be the command
switch.

If your cluster has Catalyst 2950, Catalyst 2900 XL, and Catalyst 3500 XL switches, the Catalyst 2950
switch should be the command switch. The Catalyst 2950 switch that has the latest software should be
the command switch.

If your switch cluster has Catalyst 1900, Catalyst 2820, Catalyst 2900 XL, and Catalyst 3500 XL
switches, either the Catalyst 2900 XL or Catalyst 3500 XL should be the command switch. The Catalyst
2900 or 3500 XL switch that has the latest software should be the command switch.

| oL-1644-02
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Features

Table 5 lists the cluster capabilities and software versions for the switches.

Table 5 Switch Software and Cluster Capability

Switch 10S Release Cluster Capability

Catalyst 3550 Release 12.1(4)EAL1 or later Member or command switch
Catalyst 3500 XL Release 12.0(5.1)XU or later Member or command switch
Catalyst 2950 Release 12.0(5.2)WC(1) or later |Member or command switch
Catalyst 2900 XL Release 12.0(5.1)XU or later Member or command switch
(8-MB switches)

Catalyst 2900 XL Release 11.2(8.5)SA6 Member switch only

(4-MB switches) (recommended)

Catalyst 1900 and 2820 |Release 9.00(-A or -EN) Member switch only

Some versions of the Catalyst 2900 XL software do not support clustering, and if you have a cluster with
switches that are running different versions of IOS software, software features added on the latest release
might not be reflected on switches running the older versions. For example, if you start Visual Switch
Manager (VSM) on a Catalyst 2900 XL switch running Release 11.2(8)SA6, the windows and
functionality can be different from a switch running Release 12.0(5)WC(1) or later.

The CMS is not forward-compatible, which means that if a member switch is running a software version
later than the release running on the command switch, the new features are not available on the member
switch. If your member switch is a new device that is running a software release later than the software
release on the command switch, it appears as an unknown device in the Front Panel view. You cannot
configure any parameters or generate a report through CMS for that member; instead, you must launch
the Device Manager application to perform configuration and to obtain reports for that member.

For a detailed list of key features for this software release, refer to the Catalyst 2950 Desktop Switch
Software Configuration Guide.

Limitations and Restrictions

Read this section before you begin working with the switches. Some features might not work as
documented, and some features could be affected by recent changes to the switch hardware or software.

Port Configuration Conflicts

Certain combinations of port features create configuration conflicts (see Table 6). If you try to enable
incompatible features, CMS issues a warning message, and you cannot make the change. Reload the
page to refresh CMS.

r Features
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Important Notes

In Table 6, No means that the two referenced features are incompatible and should not both be enabled;
Yes means that both can be enabled at the same time and do not cause an incompatibility conflict. A dash
means not applicable.

Table 6 Conflicting Features
SPAN SPAN Connect to Protected

Port Group  |Port Security |Source Port |Destination Port |Cluster? Port 802.1X Port
Port Group - No Yes No Yes Yes No
Port Security No - Yes No Yes No No
SPAN Source Port Yes Yes - No Yes Yes! Yes
SPAN Destination No No No - Yes Yes No
Port
Connect to Cluster | Yes Yes Yes Yes - Yes -
Protected Port Yes No Yes! Yes! Yes - -
802.1X Port No No Yes No - - -

1. Switch Port Analyzer (SPAN) can operate only if the monitor port or the port being monitored is not a protected port.

SPAN Limitations

When using the Switched Port Analyzer (SPAN) feature, the monitoring port receives copies of sent and
received traffic for all monitored ports. If the monitoring port is 50 percent oversubscribed for a
sustained period of time, it will probably become congested. One or more of the ports being monitored
might also experience a slowdown.

Important Notes

This section describes important information related to this IOS release.

Read-Only Mode in CMS

CMS provides two levels of access to the configuration options. If your privilege level is 15, you have
read-write access to CMS. If your switch privilege level is from 1 to 14, you have read-only access to

CMS. In the read-only mode, some show commands are not available when these switches are running
these software releases:

e (Catalyst 2900 XL or Catalyst 3500 XL member switches running Cisco IOS Release 12.0(5)WC2
or earlier

e Catalyst 2950 member switches running Cisco IOS Release 12.0(5)WC?2 or earlier
e (Catalyst 3550 member switches running Cisco IOS Release 12.1(6)EAL1 or earlier

Therefore, the windows that use these show commands do not display data. These windows display an
error message.

| oL-1644-02

SPAN Limitations ]



Il Documentation Notes

In the Front Panel view or Topology view, CMS does not display error messages. In the Front Panel view,
if the switch is running one of the software releases listed previously, the device LEDs do not appear. In
Topology view, if the member is an LRE switch, the customer premises equipment (CPEs) connected to
the switch do not appear. The Bandwidth and Link graphs also do not appear in these views.

To view switch information, you need to upgrade the member switch software. For information about
upgrading switch software, see the “Upgrading the Switch Software” section on page 25.

Connecting Catalyst 2950G-24-EI-DC Switches to DC Power

When wiring the DC-input power source, you must use 18-gauge copper wire instead of the
12- or 14-gauge wire specified in the Catalyst 2950 Desktop Switch Hardware Installation Guide.

Connecting Catalyst 2950G-24-EI-DC Switches to Compatible Devices

When connecting the 10/100 ports on Catalyst 2950G-24-EI-DC switches to compatible devices, if
intrabuilding lightning surge protection is required, you must use shielded twisted-pair, Category 5
cables. Make sure that the cable shield is terminated properly at both ends.

Changing the Management VLAN

The management interface configuration command is not supported in Release 12.1(6)EA?2 or later. To
shut down the current management VLAN interface and to enable the new management VLAN interface,
use the shutdown and no shutdown interface configuration commands. Refer to the Catalyst 2950
Desktop Switch Command Reference for information about using the shutdown interface configuration
command.

Documentation Notes

This section describes documentation notes related to this IOS release.

Correction to the Software Documentation

The match class-map configuration command is documented incorrectly in the Catalyst 2950 Desktop
Switch Software Configuration Guide and the Catalyst 2950 Desktop Switch Command Reference.
This is the correct command:

match access-group {acl-index | name acl-name}

Addition to the Command Reference

The interface range global configuration command was omitted in the Catalyst 2950 Desktop Switch
Command Reference.

Connecting Catalyst 2950G-24-EI-DC Switches to DC Power
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interface range

Documentation Notes

Use the interface range global configuration command to enter interface range configuration mode and
to execute a command on multiple ports at the same time. Use the no form of this command to remove
an interface range.

interface range port-range

no interface range port-range

Syntax Description

Defaults

Command Modes

port-range Port range. For a list of valid values for port-range, see the “Usage Guidelines”
section.

This command has no default setting.

Global configuration

Command History

Usage Guidelines

Release Modification

12.1(6)EA2 This command was first introduced.

When you enter interface range configuration mode, all interface parameters that you enter are attributed
to all interfaces within the range.

For VLANSs, you can use the interface range command only on existing VLAN interfaces. To display
VLAN interfaces, enter the show running-config privileged EXEC command. VLANs not displayed
cannot be used in the interface range command. The commands entered under the interface range
command are applied to all existing VLAN interfaces in the range.

All configuration changes made to an interface range are saved to nonvolatile RAM (NVRAM), but the
interface range itself is not saved to NVRAM.

You can enter the interface range by specifying up to five interface ranges.

You can define up to five interface ranges with a single command, with each range separated by a
comma.

All interfaces in a range must be the same type; that is, all Fast Ethernet ports, all Gigabit Ethernet ports,
all EtherChannel ports, or all VLANS.

These are the valid values for port-range type and interface:
e vlan vian-id, where vian-id is from 1 to 1001
e port-channel port-channel-number, where port-channel-number is from 1 to 6
e fastethernet interface-id

e gigabitethernet interface-id

| oL-1644-02
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Examples

For physical interfaces, the interface-id is defined as a slot/number (where slot is always 0 for the
Catalyst 2950 switch), and the range can be entered as type 0/number - number (for example,
gigabitethernet0/1 - 2).

When you define a range, you must enter a space before and after the hyphen (-):
interface range gigabitethernet0/1 - 2

A single interface can also be specified in port-range (this would make the command similar to the
interface interface-id global configuration command).

This example shows how to use the interface range command to enter interface range configuration
mode to apply commands to two ports:

Switch(config)# interface range gigabitethernet0/1 - 2
Switch(config-if-range)#

Related Commands

Command Description

show running-config Displays the configuration information running on the switch. For syntax
information, select Cisco IOS Configuration Fundamentals Command
Reference for Release 12.1 > Cisco 10S File Management Commands >
Configuration File Commands.

Correction to the Software Configuration Guide

The procedures in the "Recovering from a Command Switch Failure," section in Chapter 14 of the
Catalyst 2950 Desktop Switch Software Configuration Guide are incorrect. These are the correct
procedures:

Replacing a Failed Command Switch with a Cluster Member

Step 1
Step 2

Step 3

Step 4

Step 5
Step 6

To replace a failed command switch with a command-capable member in the same cluster, follow these
steps:

Disconnect the command switch from the member switches, and physically remove it from the cluster.

Insert the member switch in place of the failed command switch, and duplicate its connections to the
cluster members.

Start a CLI session on the new command switch.

You can access the CLI by using the console port or, if an IP address has been assigned to the switch, by
using Telnet. For details about using the console port, refer to the switch hardware installation guide.

At the switch prompt, enter privileged EXEC mode:

Switch> enable
Switch#

Enter the password of the failed command switch.
Enter global configuration mode.

Switch# configure terminal
Enter configuration commands, one per line. End with CNTL/Z.

Correction to the Software Configuration Guide
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Step7 Remove the member switch from the cluster.

Switch(config)# no cluster commander-address

Step8  Return to privileged EXEC mode.

Switch(config)# end
Switch#

Step9  Use the setup program to configure the switch IP information.

This program prompts you for IP address information and passwords. From privileged EXEC mode,
enter setup, and press Return.

Switch# setup
--- System Configuration Dialog ---
Continue with configuration dialog? [yes/nol: y

At any point you may enter a question mark '?' for help.
Use ctrl-c to abort configuration dialog at any prompt.
Default settings are in square brackets '[]'.

Basic management setup configures only enough connectivity
for management of the system, extended setup will ask you
to configure each interface on the system

Would you like to enter basic management setup? [yes/no]:

Step10 Enter Y at the first prompt.

The prompts in the setup program vary depending on the member switch that you selected to be the
command switch:

Continue with configuration dialog? [yes/nol: ¥y
or
Configuring global parameters:
If this prompt does not appear, enter enable, and press Return. Enter setup, and press Return to start
the setup program.
Step11  Respond to the questions in the setup program.

When prompted for the host name, recall that on a command switch, the host name is limited to
28 characters; on a member switch to 31 characters. Do not use -n, where n is a number, as the last
characters in a host name for any switch.

When prompted for the Telnet (virtual terminal) password, recall that it can be from 1 to 25 alphanumeric
characters, is case sensitive, allows spaces, but ignores leading spaces.

Step12 When prompted for the enable secret and enable passwords, enter the passwords of the failed command
switch again.

Step13 When prompted, enable the switch as the cluster command switch, and press Return.
Step14 When prompted, assign a name to the cluster, and press Return.

The cluster name can be 1 to 31 alphanumeric characters, dashes, or underscores.
Step15 After the initial configuration displays, verify that the addresses are correct.
Step16 If the displayed information is correct, enter Y, and press Return.

If this information is not correct, enter N, press Return, and begin again at Step 9.

Step17  Start your browser, and enter the IP address of the new command switch.

Correction to the Software Configuration Guide
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Step 18

From the Cluster menu, select Add to Cluster to display a list of candidate switches to add to the cluster.

Replacing a Failed Command Switch with Another Switch

Step 1

Step 2

Step 3

Step 4
Step 5

Step 6

Step 7

To replace a failed command switch with a switch that is command-capable but not part of the cluster,
follow these steps:

Insert the new switch in place of the failed command switch, and duplicate its connections to the cluster
members.

Start a CLI session on the new command switch.

You can access the CLI by using the console port or, if an IP address has been assigned to the switch, by
using Telnet. For details about using the console port, refer to the switch hardware installation guide.

At the switch prompt, enter privileged EXEC mode:

Switch> enable

Switch#

Enter the password of the failed command switch.

Use the setup program to configure the switch IP information.

This program prompts you for IP address information and passwords. From privileged EXEC mode,
enter setup, and press Return.

Switch# setup
--- System Configuration Dialog ---
Continue with configuration dialog? [yes/nol: y

At any point you may enter a question mark '?' for help.
Use ctrl-c to abort configuration dialog at any prompt.
Default settings are in square brackets '[]'.

Basic management setup configures only enough connectivity
for management of the system, extended setup will ask you
to configure each interface on the system

Would you like to enter basic management setup? [yes/no]:

Enter Y at the first prompt.

The prompts in the setup program vary depending on the switch that you selected to be the command
switch:

Continue with configuration dialog? [yes/nol: ¥y
or

Configuring global parameters:

If this prompt does not appear, enter enable, and press Return. Enter setup, and press Return to start
the setup program.

Respond to the questions in the setup program.

When prompted for the host name, recall that on a command switch, the host name is limited to 28
characters. Do not use -n, where n is a number, as the last characters in a host name for any switch.

When prompted for the Telnet (virtual terminal) password, recall that it can be from 1 to 25 alphanumeric
characters, is case sensitive, allows spaces, but ignores leading spaces.

Correction to the Software Configuration Guide
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Step 8

Step 9
Step 10

Step 11
Step 12

Step 13

Caveats

Open Caveats

Caveats H

When prompted for the enable secret and enable passwords, enter the passwords of the failed command
switch again.

When prompted, enable the switch as the cluster command switch, and press Return.

When prompted, assign a name to the cluster, and press Return.

The cluster name can be 1 to 31 alphanumeric characters, dashes, or underscores.

When the initial configuration displays, verify that the addresses are correct.

If the displayed information is correct, enter Y, and press Return.

If this information is not correct, enter N, press Return, and begin again at Step 9.

Start your browser, and enter the IP address of the new command switch.

From the Cluster menu, select Add to Cluster to display a list of candidate switches to add to the cluster.

This section describes possible unexpected activity by IOS Release 12.1(6)EA2a:

CSCdw15773

If the multicast VLAN registration (MVR) query-response time on an MVR receiver port is set to
the default value (0.5 seconds), when the receiver port leaves a multicast group and rejoins it, the
receiver port might not send or receive traffic for up to 10 seconds.

The workaround is to enter the mvr querytime 100 global configuration command to set the MVR
query-response time to 10 seconds, which is the general-query-response time to prune member
ports.

CSCdw13531

If CISCO-FLASH-MIB is included in the MIB walk on a Catalyst 2950 switch, the MIB walk halts
in CISCO-FLASH-MIB.

The workaround is to remove CISCO-FLASH-MIB from the MIB walk.
CSCdw06738

Traffic interruption can occur for several seconds during a cross-stack UplinkFast (CSUF) root-port
transition.

There is no workaround.
CSCdw19137

When you are using the AVVID Voice Wizard in CMS, some cluster members might fail if the client
PC or workstation running CMS is not connected to the cluster through the command switch.

The workaround is to make the command switch the entry point for the client PC or workstation
running CMS.

CSCdv90806

On the Catalyst 2950 switches, you can monitor incoming traffic on multiple ports by using the CLI;
however, you can only select one port if you are using CMS.

The workaround is to use the CLI to monitor incoming traffic on multiple ports.

| oL-1644-02
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CSCdw11223

If you configure an SNMP community string larger than 123 characters and then configure a VLAN
with an ID greater than 99, the Catalyst 2950 switch resets and restarts.

The workaround is to configure an SNMP community string up to 123 characters.
CSCdw10837

When a Catalyst 2950 cluster command-switch is running Cisco IOS Release 12.1(6)EA2 or later
and you enter the no cluster commander-address global configuration command on a member
switch of this cluster, the member switch cannot be removed from the cluster if there are any
member switches beyond that member switch.

The workaround is to enter the no cluster member n global configuration command on the
command switch to remove the member from the cluster.

CSCdt27223

When you enter the show controllers ethernet-controller interface-id or show interfaces
interface-id counters privileged EXEC command, if a large number of erroneous frames are
received on an interface, the receive-error counts might be smaller than the actual values, and the
receive-unicast frame count might be larger than the actual frame count.

There is no workaround.
CSCdt09918

If the cluster command-switch is a Catalyst 2900 XL switch, a Catalyst 2950 switch running
software earlier than Release 12.1(6)EA2, or a Catalyst 3500 XL switch that is connected to a
Catalyst 2950 switch running Release 12.1(6)EA2 or later or to a Catalyst 3550 switch, the
command switch does not find any cluster candidates beyond the Catalyst 2950 or 3550 switch if it
is not a member of the cluster.

The workaround is to add the Catalyst 2950 or 3550 switch to the cluster. You can then see any
cluster candidates connected to it.

CSCdw06074

Layer 3 CPU packets from a SPAN-source port configured to monitor transmitted traffic are not
mirrored to the SPAN-destination port on a Catalyst 2950 switch.

There is no workaround.
CSCdv82224

If a stack contains Catalyst 3550, 3500 XL, or 2900 XL switches, then the cross-stack UplinkFast
(CSUF) feature does not work if the management VLAN on these switches is changed to a VLAN
other than VLAN 1.

The workaround is to ensure that the management VLAN of all the Catalyst 3550, 3500 XL, and
2900 XL switches in the stack is set to VLAN 1.

CSCdv14833

When the show running-config or write memory privileged EXEC command is entered, it might
take up to 8 seconds before the current configuration appears on the Catalyst 2950 switch. This is
because it takes a large number of system resources to execute this command.

There is no workaround.

r Open Caveats
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CSCdv02941

In some network topologies, when UplinkFast is enabled on all Catalyst 2950 switches and
BackboneFast is not enabled on all switches, a temporary loop might be caused when the STP root
switch is changed.

The workaround is to enable BackboneFast on all switches.
CSCdv19671

At times, the Window-XP pop-up window might not appear while authenticating a client
(supplicant) because the user information is already stored in Windows XP. However, the Extensible
Authentication Protocol over LAN (EAPOL) response to the switch (authenticator) might have an
empty userid that causes the 802.1X port to be deauthenticated.

The workaround is to manually re-initiate authentication by either logging off or detaching the link
and then re-connecting it.

CSCdv67047

The ip http authentication enable global configuration command is not saved to the configuration
file because this is the default configuration. Therefore, this configuration is lost after a reboot.

The workaround is to manually enter the command again after a reboot.

CSCdv56582

In the CMS topology view, icons for the fiber-optic, ATM, and FDDI links are not visible.
There is no workaround.

CSCdv44005

A Catalyst 2950 command switch running IOS Release 12.1(6)EA2 cannot use the rcommand
privileged EXEC command to start a Telnet session on a Catalyst 3550 member running

I0S Release 12.1(4)EA1, when the aaa authorization exec default group tacacs+ global
configuration command is configured on both the command switch and the member.

The workaround is to upgrade the Catalyst 3550 switch to IOS Release 12.1(6)EAla.
CSCdv34505

The Catalyst 2950 command switch might not show the Catalyst 1900, Catalyst 2820, and Catalyst
2900 XL 4-MB (models C2908-XL, C2916M-XL, C2924C-XL, and C2924-XL) switches as
candidates even though their management VLAN is the same as the command switch. This occurs
only when their management VLAN is not VLAN 1.

There is no workaround.
CSCdv62271

There might be a link on the Fast Ethernet port of the Catalyst 2950switch when it is forced to 10
Mbps and full-duplex mode and its link partner is forced to 100 Mbps and forced duplex mode. The
LED on the Catalyst 2950 switch might display the link, and the error counters might increment.

The workaround is to configure both sides of a link to the same speed or use auto-negotiation.
CSCdu83640

The receive count output for the show controllers ethernet-controller interface-id privileged
EXEC command shows the incoming packets count before the ASIC makes a decision of whether
to drop the packet or not. Therefore, for ports in the STP blocking states, even though the receive
count shows incoming frames, the packet is not forwarded to the other port.

There is no workaround.
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CSCdv49871

A Catalyst 2950 command switch can discover only the first Catalyst 3550 switch if the link between
the Catalyst 3550 switches is an 802.1Q trunk and the native VLAN is not the same as the
management VLAN of the Catalyst 2950 switch or if the link between the Catalyst 3550 switches
is an ISL trunk and the management VLAN is not VLAN 1.

The workaround is to connect Catalyst 3550 switches by using the access link on the command
switches management VLAN or to configure an 802.1Q trunk with a native VLAN that is the same
as the management VLAN of the command switch.

CSCdv27247

If two Catalyst 2950 switches are used in a network and if access ports are used to connect two
different VLANs whose VLAN IDs are separated by the correct multiple of 64, it is possible to
create a situation where the two switches use the same bridge ID in the same spanning-tree
instances. This might cause a loss of connectivity in the VLAN as the spanning tree blocks the ports
that should be forwarding.

The workaround is to not cross-connect VLANSs. For example, do not use an access port to connect
VLAN 1 to VLAN 65 on either the same switch or from one switch to another switch.

CSCdv45190

On a Catalyst 2950 switch, the Multicast VLAN Registration (MVR) receiver port joins only 255
groups when the Internet Group Management Protocol (IGMP) join message is sent to all 256 MVR
groups configured. Multicast data for the 256th group is not received.

The workaround is to set the mode to dynamic for Catalyst 2950 switches that are connected to
IGMP-capable devices. Then, MVR members can join any group but can only support 255 IP
multicast streams at any given time.

CSCdt24814 (formerly CSCdt2481)

A source-based distribution port group does not share the broadcast with all the group members.
When the destination of the packets is a broadcast or unknown unicast or multicast, the packets are
forwarded only on one port member of a port group, instead of being shared among all members of
the port group.

There is no workaround.
CSCdt48011
Two problems occur when the Catalyst 2950 switch is in transparent mode:

— If the switch is a leaf switch, any new VLANSs added to it are not propagated upstream through
VTP messages. As a result, the switch does not receive flooded traffic for that VLAN.

— If the switch is connected to two VTP servers, it forwards their pruning messages. If the switch
has a port on a VLAN that is not requested by other servers through their pruning messages, it
does not receive flooded traffic for that VLAN.

There is no workaround.
CSCds20365

Internal loopback in half-duplex mode causes input errors. We recommend that you configure the
PHY to operate in full duplex before setting the internal loopback.

There is no workaround.
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CSCdt83016

When the Catalyst 2950 switch boots up without being configured, it prompts the user with a
configuration dialog. The switch allows the user to omit the dialog and to enable traps without
configuring a community string. If the host trap receiver is configured without defining the
community strings, when the switch attempts to generate a trap, it fails and displays an error
message.

The workaround is to follow the configuration sequence by creating a community string before
configuring traps for the host.

CSCdr96565

Aging of dynamic addresses does not always occur exactly after the specified aging time elapses. It
might take up to three times this time period before the entries are removed from the table.

There is no workaround.
CSCdt48569

If any VLAN other than VLAN 1 is configured as the management VLAN, the switch reports an
incorrect shutdown for VLAN 1. VLAN 1 is not administratively down, even though the running
configuration has shut down in VLAN 1.

There is no workaround.
CSCds68177

The UniDirectional Link Detection (UDLD) protocol does not always detect a unidirectional link
when there is a loop between the TX and RX strands on the same port (TX/RX loop condition).

This is an intermittent problem, and there is no workaround.
CSCds58369

If the switch gets configured from the dynamic IP pool, a duplicate or different IP address might be
assigned.

The workaround is to make sure that the DHCP server contains reserved addresses that are bound to
each switch by the switch hardware address so that the switch does not obtain its IP address from
the dynamic pool.

CSCdp67822

CMS requires a Java plug-in from Sun Microsystems. If you are using Internet Explorer and you
disable Java plug-ins by using the Java Plug-In Control Panel, the initial Splash screen shows that
the plug-in and Java are enabled, but Internet Explorer fails.

The workaround is to not disable Java plug-ins on the Java Plug-In Control Panel.
CSCdp82224

The CMS Time Management window supports the configuration of the Network Time Protocol
(NTP) and system time. When you make changes on this window from a command switch, Java
propagates the changes to all cluster members. A conflict can arise if you configure NTP and also
use the Set Daylight Saving Time and Set Current Time tabs.

To avoid a possible conflict, either set the system time for the entire cluster on the command switch,
or configure NTP on the command switch to use an NTP server to provide time to the cluster. Do
not use both methods at the same time.

CSCdp82354

You can use Cluster Manager to configure an Hot Standby Router Protocol (HSRP) standby group
and bind it to a cluster. However, you cannot use Cluster Manager to configure more than one
standby group. If you want to configure more than one standby group, use the CLI.
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CSCdp70389

When changing the management VLAN on a cluster with command-switch redundancy enabled, the
cluster can break if HSRP is configured on any of the cluster members in the new management
VLAN.

The workaround is to not change the management VLAN to a VLAN where a member is configured
as part of a standby group.

CSCdp85954

Root guard is inconsistent when configured on a port that is in the STP blocked state at the time of
configuration.

CSCdp49419

HSRP does not support a virtual MAC address entry or a built-in address (BIA) for a cluster.
CSCdp97517

All members of an HSRP standby group must be cluster members.

CSCdp30543

If the storm control filter is enabled for unicast or multicast traffic and the rising threshold is
reached, all traffic on the port is filtered. No unicast, multicast, or broadcast traffic is forwarded
from the port.

CSCdp87748

Cisco IOS does perform some checks on entered IP addresses. For example, it does not allow the
broadcast address to be entered. However, it does not check for the broadcast address on the same
subnet as the HSRP Versatile Interface Processor (VIP) or the management VLAN IP address. This
means that you could configure HSRP with a virtual IP address that is the same as the network
broadcast address.

There is no workaround.
CSCdp75220

If you use the command switch Domain Name System (DNS) server name to start CMS for a
member that is running an earlier software release, CMS might not display the switch image, or it
might display the command switch image. This can also occur when a standby group is configured
for a cluster and you access CMS by entering the command-switch IP address and not the virtual IP
address.

The workaround is to always use the command-switch IP address to access CMS. If a standby group
is configured for a cluster, always use the virtual IP address to access CMS.

CSCdp62807

If you click the list of switches in CMS and press the Page Down key on the keyboard, the entire list
moves to the bottom of the window. This only happens with Windows NT.

The workaround is to collapse the list into a single icon, which returns the list to the top of the
window.

r Open Caveats
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Resolved Caveats

This problem was resolved in Cisco IOS Release 12.1(6)EA2a:

CSCdw29898

When you are using the Remote Authentication Dial-In User Service (RADUIS) client for
Extensible Authentication Protocol (EAP) authentication, the Microsoft Windows2000 Internet
Authentication Server authenticates only users with valid passwords.

These problems were resolved in Cisco IOS Release 12.1(6)EA2:

CSCdv35805

If you are copying the configuration file using ciscoConfigCopyMIB from a Catalyst 2950 switch
by using Simple Network Management Protocol (SNMP) manager, the switch no longer reloads the
configuration.

CSCdv16305

A broadcast storm no longer occurs when two 100BASE-FX ports on a Catalyst 2950 switch are
connected to the 100BASE-FX ports on another Catalyst 2950 switch if these ports are in trunk
mode and one of the ports is administratively down.

CSCds72421

If the management VLAN is changed to any other VLAN from VLAN | and VLAN 1 is shut down,
the IP address configured in the new management VLAN now appears in the show cdp neighbor
detail privileged EXEC command output.

CSCdt57346

When you enter the show rmon history user EXEC command, the value for the collision is now
unique for each sample.

CSCdu09410

The ifSpeed of the interfaces now reports the default value of the visible bandwidth when the link
is down and reports the configured and assigned values when the link is up.

CSCdu37367

The clear counters and clear counters fastethernet port interface configuration commands now
clear the port security counters. These commands also clear the other counters for the interface.

CSCdu49099

Changing the VLAN Trunking Protocol (VTP) mode to transparent no longer causes a virtual type
terminal session to lock up when executing commands, such as the show vlan privileged EXEC
command, that require access to the VLAN- and VTP-related data.

In addition, ports that were shut down during VTP mode change now come back up automatically
when VTP is stable.

CSCdu67033

The output count displayed by the show interface privileged EXEC command output now appears
correctly when the count is greater than 4,294,967,296 packets.

CSCdu88701

When performing an snmpwalk SNMP operation on the dot1dTpFdbTable (1.3.6.1.2.1.17.4.3), the
response no longer omits all entries of show mac in the display in which the first byte of the host
MAC address is greater than 0x00.
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CSCdv21552

High CPU utilization no longer occurs when a switch boots with a VLAN (without an IP address)
in the shutdown state while another active VLAN has an IP address.

CSCdv41819

Enabling spanning-tree UplinkFast no longer causes brief spanning-tree loops if the configuration
message from the root switch of the spanning tree ages out.

CSCdt04001

When you change the privilege level for an interface on the Catalyst 2950 switches, you can execute
commands with the newly configured privilege level. The switch now saves the arguments
associated with the command, and after a reload, the configured commands are executable.

CSCdt24089

If the Catalyst 2950 switch contains multicast addresses, the MIB walk of Dot1dTpFdbEntry no
longer consumes excess CPU cycles on the switch.

CSCdt68204

If you continuously ping a switch from a PC and the links from the switch to the network are brought
down, when the link from the switch to the network is restored, pinging now resumes.

CSCdt59751

The no snmp-server enable traps snmp [authentication] global configuration command is not
supported by this software release.

CSCdu87426

The 100BASE-FX ports in a Fast EtherChannel port group no longer loop packets when the
connected device resets or reloads.

CSCdv47498

The SNMP walk of the Dot1dTpFdbTable no longer causes the switch to halt and put an SNMP CPU
HOG error message in the logging buffer.

CSCdv51153

SNMP MIB variables etherStatsEntry does not display any values in Cisco IOS Release 12.0(5)XU
or later.

CSCdt88908

When IGMP packets are received on a port for a non-existent VLAN, the Catalyst 2950 switch no
longer loses buffer space on that port.

CSCds72421

If you shut down the management VLAN on VLAN 1 on a Catalyst 2950 switch, set the management
VLAN to 999, and then again use the shutdown command to shut down VLAN 1, the IP address of
VLAN 999 now appears correctly in the show cdp neighbor detail command output on a connected
device.

CSCdt74555

When a MAC address is learned on a member of a port group created between a Catalyst 2950 and
Catalyst 2900 or 3500 XL switch, the same MAC address gets deleted and relearned on another port
member of the port group on the 2900 or 3500 XL switch. As a result, a real-time diagnostic message
reporting this address relearning behavior no longer appears.

Resolved Caveats
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Initial Configuration

You can assign IP information to your switch in one of these ways:
e Using the Setup program (switch’s configuration dialog)

e Using DHCP-based auto configuration (refer to the Catalyst 2950 Desktop Switch Software
Configuration Guide)

e Manually assigning an IP address (refer to the Catalyst 2950 Desktop Switch Software Configuration
Guide)

Setting Up the Catalyst 2950

Note

Step 1

Step 2

Step 3

Step 4

The first time that you access the switch, it runs a setup program that prompts you for an IP address and
other configuration information necessary for the switch to communicate with the local routers and the
Internet. This information is also required if you plan to use the CMS to configure and manage the
switch.

If the switch will be a cluster member managed through the IP address of the command switch, it is not
necessary to assign IP information or a password. If you are configuring the switch as a standalone
switch or as a command switch, you must assign IP information.

Follow these steps to create an initial configuration for the switch:

Enter Yes at the first two prompts.

Would you like to enter the initial configuration dialog? [yes/no]: yes

At any point you may enter a question mark '?' for help.
Use ctrl-c to abort configuration dialog at any prompt.
Default settings are in square brackets '[]'.

Basic management setup configures only enough connectivity
for management of the system, extended setup will ask you
to configure each interface on the system.

Would you like to enter basic management setup? [yes/no]: yes

Enter a host name for the switch, and press Return.

On a command switch, the host name is limited to 28 characters; on a member switch to 31 characters.
Do not use -n, where n is a number, as the last character in a host name for any switch.

Enter host name [Switch]: host_name

Enter a secret password, and press Return.

The password can be from 1 to 25 alphanumeric characters, can start with a number, is case sensitive,
allows spaces, but ignores leading spaces.

Enter enable secret: secret_password

Enter an enable password, and press Return.

Enter enable password: enable_password
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Step 5

Step 6

Step 7

Step 8

Step 9

Step 10

Enter a virtual terminal (Telnet) password, and press Return.

The password can be from 1 to 25 alphanumeric characters, is case sensitive, allows spaces, but ignores
leading spaces.

Enter virtual terminal password: terminal-password

(Optional) Configure the Simple Network Management Protocol (SNMP) by responding to the
prompts.

Enter the interface name (physical interface or VLAN name) of the interface that connects to the
management network, and press Return. For this release, always use vlanl as that interface.

Enter interface name used to connect to the
management network from the above interface summary: vlanl

Configure the interface by entering the switch IP address and subnet mask and pressing Return:

Configuring interface vlanl:

Configure IP on this interface? [yes]: yes

IP address for this interface: 10.4.120.106

Subnet mask for this interface [255.0.0.0]: 255.255.255.0

Enter Y to configure the switch as the cluster command switch. Enter N to configure it as a member
switch or as a standalone switch.

If you enter N, the switch appears as a candidate switch in the CMS. In this case, the message in Step 10
does not appear.

Would you like to enable as a cluster command switch? [yes/nol: yes

Assign a name to the cluster, and press Return.

Enter cluster name: cluster_name

The cluster name can be 1 to 31 alphanumeric characters, dashes, or underscores.
The initial configuration appears:

The following configuration command script was created:

hostname host_name

enable secret 5 $1$Max7$Qgr9eXBhtcBJw3KK7bc850
enable password grandkeyl

line vty 0 15

password grandkey

snmp-server community public

|

no ip routing

|
interface Vlanl
no shutdown
ip address 172.20.139.145 255.255.255.224
|
interface Vlan2
shutdown
no ip address
!
interface FastEthernet0/1
|
interface FastEthernet0/2
|
. .<output abbreviated)
it
interface GigabitEthernet0/1

Setting Up the Catalyst 2950
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Step 11

Initial Configuration W

interface GigabitEthernet0/2
!

end

These choices appear:

[0] Go to the IOS command prompt without saving this config.
[1] Return back to the setup without saving this config.

[2] Save this configuration to nvram and exit.

Enter your selection [2]:

Make your selection, and press Return.

After you complete the setup program, the switch can run the created default configuration. If you
want to change this configuration or want to perform other management tasks, use one of these tools:

e CMS from your browser (See the “Creating Clusters with Different Releases of IOS Software”
section on page 5 and the “Accessing CMS” section on page 23.)

¢ Command-line interface (CLI) (Refer to the software configuration guide.)

The switch software configuration guide provides more information about how to set a password to
protect the switch against unauthorized Telnet access and how to access the switch if you forget the
password.

CMS

A browser plug-in is required to access CMS. See the “Creating Clusters with Different Releases of IOS
Software” section on page 5. After you have assigned an IP address to the switch and installed the
plug-in, you can access the switch from your browser and use the Cluster Management application to
configure other switches. To use the web-based tools, see the “Hardware and Software Requirements for
the Cluster Management Suite” section on page 3 to set up the appropriate browser options.

Configuring Netscape Communicator (All Versions)

Step 1
Step 2
Step 3
Step 4
Step 5

Follow these steps to configure Netscape Communicator:

Start Netscape Communicator.

From the menu bar, select Edit > Preferences.

In the Preferences window, click Advanced.

Check the Enable Java, Enable JavaScript, and Enable Style Sheets check boxes.

From the menu bar, select Edit > Preferences.
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Step 6
Step 7

In the Preferences window, click Advanced Cache, and select Every time.

Click OK to return to the browser Home page.

Configuring Microsoft Internet Explorer (4.01)

Step 1
Step 2
Step 3

Step 4

Follow these steps to configure Microsoft Internet Explorer 4.01:

Start Internet Explorer.
From the menu bar, select View > Internet Options.
In the Internet Options window, click the Advanced tab.

a. Scroll through the list of options until you see Java VM. Check the Java logging enabled and Java
JIT compiler enabled check boxes.

b. Click Apply.
In the Internet Options window, click the General tab.
a. In the Temporary Internet Files section, click Settings.

b. In the Settings window, select Every visit to the page, and click OK.

Configuring Microsoft Internet Explorer (5.0)

~

Note

Step 1
Step 2
Step 3

Step 4

During the installation of this browser, make sure to check the Install Minimal or Customize Your
Browser check box. In the Component Options window in the Internet Explorer 5 section, make sure to
check the Microsoft Virtual Machine check box to display applets written in Java.

Follow these steps to configure Microsoft Internet Explorer 5.0:

Start Internet Explorer.
From the menu bar, select Tools > Internet Options.
In the Internet Options window, click the Advanced tab.

a. Scroll through the list of options until you see Microsoft VM. Check the Java logging enabled and
JIT compiler for virtual machine enabled check boxes.

b. Click Apply.
In the Internet Options window, click the General tab.
a. In the Temporary Internet Files section, click Settings.

b. In the Settings window, select Every visit to the page, and click OK.

Configuring Microsoft Internet Explorer (4.01)
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If you are using Microsoft Internet Explorer 5.0 to make configuration changes to the switch, note that
this browser does not automatically reflect the latest configuration changes. Make sure you click the
browser Refresh button for every configuration change.

Displaying the Access Page

Step 1

Step 2

Step 3

After the browser is configured, display the Cluster Management Suite access page:

Enter the switch IP address in the browser Location field (Netscape Communicator) or Address field
(Internet Explorer), and press Return.

Enter your username and password when prompted. The password provides level 15 access. The Cisco
Systems Access page appears. For more information on Setting Passwords and Privilege Levels, refer to
the Catalyst 2950 Desktop Switch Software Configuration Guide.

~

Note  If no username is configured on the switch, leave the username field blank.

Click Web Console to display the appropriate CMS application.

Upgrading the Switch Software

This section provides topics about upgrading the switch software:
e “Guidelines for Upgrading Switch Software” section on page 26
e “Overview of the Switch Upgrade Process” section on page 26
e “Upgrading the Switch Software” section on page 25

¢ “Downloading the New Software and TFTP Server Application to Your Management Station”
section on page 28

e “Copying the Current Startup Configuration from the Switch to a PC or Server” section on page 28
e “Using Cluster Manager to Upgrade One or More Switches” section on page 29

e “Using the CLI to Upgrade a Catalyst 2950 Switch” section on page 30

e “Using the CLI to Upgrade Member Switches” section on page 32

The Catalyst 2950-12 and 2950-24 switches cannot be upgraded to Cisco IOS Release 12.1(6)EA2 or
later.

Before upgrading your switch to Cisco IOS Release 12.1(6)EA2a, read the “Guidelines for Upgrading
Switch Software” section on page 26 for important information.
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~

Note  For CMS instructions for upgrading switch software to this release, refer to the online help.

Guidelines for Upgrading Switch Software

When using Cluster Manager to upgrade multiple switches from the Cisco TFTP server, the Cisco TFTP
server application can handle multiple requests and sessions. When using Cluster Manager to upgrade
multiple switches from the Cisco TFTP server, you must first disable the TFTP Show File Transfer
Progress and the Enable Logging options to avoid TFTP server failures. If you are performing
multiple-switch upgrades with a different TFTP server, it must be capable of managing multiple requests
and sessions at the same time.

Overview of the Switch Upgrade Process

The software upgrade procedure has these major steps:

e Deciding which software files to download from Cisco.com, as described in the “Upgrading the
Switch Software” section on page 25.

e Downloading the .tar file from Cisco.com, as described in the “Downloading the New Software and
TFTP Server Application to Your Management Station” section on page 28. This file contains the
I0S image and the HTML files. From Cisco.com, you can also download a TFTP server application
to copy the switch software from your PC to the switch, if necessary.

The tar command extracts the IOS image and the HTML files from the .tar file during the TFTP
copy to the switch.

e Copying the current startup configuration file, as described in the “Copying the Current Startup
Configuration from the Switch to a PC or Server” section on page 28. If the upgrade to the new
software fails or if the new startup configuration fails, you can reinstall the previous version of the
switch software and use the copy of the startup configuration file to start the switch. If a failure
occurs while copying a new image to the switch, and the old image has already been deleted, you
will need to use the XMODEM protocol to recover an image for the switch. For more information,
refer to the “Recovering from Corrupted Software” section in the “Troubleshooting” chapter of the
Catalyst 2950 Desktop Switch Software Configuration Guide.

e Using CMS or the CLI to upgrade the software on your switch or switch cluster:

— If you are using Cluster Manager to upgrade a switch, follow the steps in the “Using Cluster
Manager to Upgrade One or More Switches” section on page 29.

— If you are using the CLI to upgrade a switch, follow the steps in the “Using the CLI to Upgrade
a Catalyst 2950 Switch” section on page 30 or the “Using the CLI to Upgrade Member
Switches” section on page 32.

When you upgrade a switch, the switch continues to operate while the new software is copied to Flash
memory. If Flash memory has enough space, the new image is copied to the selected switch but does not
replace the running image until you reboot the switch. If a failure occurs during the copy process, you
can still reboot your switch by using the old image. If Flash memory does not have enough space for two
images, the new image is copied over the existing one. Features provided by the new software are not
available until you reload the switch.

Guidelines for Upgrading Switch Software
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After you upgrade your switch to Cisco IOS Release 12.1(6)EA2 or later, the tar command is replaced
by the archive tar command.

Determining the Software Version

The IOS image is stored as a .bin file in a directory that is named with the IOS release. A subdirectory
contains the HTML files needed for web management. The image is stored on the system board Flash
device (flash:).

You can use the show version user EXEC command to see the software version that is running on your
switch. In the output, check the line that begins with System image file is. It shows the directory name
in Flash memory where the image is stored.

You can also use the dir filesystem: privileged EXEC command to see the directory names of other
software images that you might have stored in Flash memory.

Which Software Files to Download from Cisco.com

Note

New software releases are posted on Cisco.com and are also available through authorized resellers.

Table 7 describes the file extensions and what they mean for the upgrade procedure. It is easier to
upgrade the switch software by using a .tar file that contains the HTML files and the IOS image. The
upgrade procedures in these release notes describe how to perform the upgrade by using a .tar file, and
you must use a .tar file to upgrade a switch through the CMS.

Table 8 lists the software files for this IOS release.

We recommend that you download the .tar file that contains the IOS image file and the HTML files. The
procedures in these release notes are for upgrading a switch by using the .tar file, and the Device
Manager and Cluster Manager are designed to upgrade a switch by using this file.

Table 7 Possible Extensions for I0S Software Files

Extension  Description

.tar A compacted file from which you can extract files by using the tar command:

Note

The .tar file contains both the IOS image file and the HTML files.

.bin The IOS image file that you can copy to the switch through TFTP.

Table 8 Catalyst 2950 Cisco 10S Software Files

Filename Description
€2950-16q412-mz.121-6.EA2a.bin IOS image file
¢2950-16q412-mz.121-6.EA2a.tar I0S image file and HTML files
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Downloading the New Software and TFTP Server Application to Your
Management Station

Step 1
Step 2

Step 3

Follow these steps to download the new software and, if necessary, the TFTP server application, from
Cisco.com to your management station:

Use Table 7 and Table 8 to identify the files that you want to download.

Download the files from one of these locations:

If you have a SmartNet support contract, go to this URL, and download the appropriate files:
http://www.cisco.com/cgi-bin/tablebuild.pl/cat2950

If you do not have a SmartNet contract, go to this URL, and download the appropriate files:
http://www.cisco.com/pcgi-bin/tablebuild.pl/cat2950

Use the CLI or web-based interface to perform a TFTP transfer of the file or files to the switch after
you have downloaded them to your PC or workstation.

The readme.txt file describes how to download the TFTP server application. New features provided by
the software are not available until you reload the software.

Copying the Current Startup Configuration from the Switch to a PC or Server

Step 1

Step 2

Step 3

Step 4

When you make changes to a switch configuration, your changes become part of the running
configuration. When you enter the command to save those changes to the startup configuration, the
switch copies the configuration to the config.text file in Flash memory. To ensure that you can recreate
the configuration if a switch fails, you might want to copy the config.text file from the switch to a PC or
server.

This procedure requires a configured TFTP server such as the Cisco TFTP server available on
Cisco.com.

Beginning in privileged EXEC mode, follow these steps to copy a switch configuration file to the PC or
server that has the TFTP server application:

Copy the file in Flash memory to the root directory of the TFTP server:

switch# copy flash:config.text tftp

Enter the IP address of the device where the TFTP server resides:

Address or name of remote host []1? iIp_address

Enter the name of the destination file (for example, config.text):

Destination filename [config.text]? yes/no

Verify the copy by displaying the contents of the root directory on the PC or server.

r Downloading the New Software and TFTP Server Application to Your Management Station
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Using Cluster Manager to Upgrade One or More Switches

Step 1

Step 2

Note

You can use the Software Upgrade feature of the Cluster Manager to upgrade all or some of the switches
in a cluster at once. Consider these conditions when doing an upgrade:

¢ You cannot upgrade Catalyst 2950, Catalyst 2900 XL, and Catalyst 3500 XL switches at the same
time. However, you can group together and upgrade Catalyst 1900 and Catalyst 2820 switches at the
same time.

e Upgrade Catalyst 1900 and Catalyst 2820 switches last. To function efficiently, these switches need
to be rebooted shortly after the upgrade occurs. If you do not click Reboot Cluster in 30 seconds
after the upgrade, the Catalyst 1900 and Catalyst 2820 switches automatically reboot.

e For Catalyst 2950, Catalyst 2900 XL, and Catalyst 3500 XL switches, enter the image_name.tar
filename in the New File Name field. The .tar file contains both the IOS image and the
web-management code.

e For Catalyst 1900 and Catalyst 2820 switches, enter the image_name.bin filename in the New File
Name field. The .bin file contains the software image and the web-management code.

Follow these steps to use Cluster Manager to upgrade software. Refer to the online help for more details.

In Cluster Manager, select Administration > Software Upgrade to display the Software Upgrade
window.

Enter the .tar filename (for Catalyst 2950, Catalyst 2900 XL and Catalyst 3500 XL switches) or the .bin
filename (for Catalyst 1900 and Catalyst 2820 switches) that contains the switch software image and
the web-management code.

You can enter just the filename or a pathname into the New Image File Name field. You do not need to
enter a pathname if the image file is in the directory that you have defined as the TFTP root directory.

You can also use Device Manager to upgrade a single switch by following the same software upgrade
procedure.

Close your browser after the upgrade process is complete.

On Catalyst 3500 XL, Catalyst 2950, and Catalyst 2900 XL, switches, new images are copied to Flash
memory and do not affect operation. The switch checks Flash memory to ensure that there is sufficient
space before the upgrade takes place. If there is enough space, the new image is copied to the switch
without replacing the old image, and after the new image is completely downloaded, the old one is
erased. In this case, you can still reboot your switch by using the old image if a failure occurs during the
copy process.

If there is not enough space in Flash memory for the new and old images, the old image is deleted, and
the new image is downloaded.

If a failure occurs while copying a new image to the switch, and the old image has already been deleted,
you need to use the XMODEM protocol to recover an image for the switch. For more information, refer
to the “Recovering from Corrupted Software” section in the “Troubleshooting” chapter of the Catalyst
2950 Desktop Switch Software Configuration Guide.

| oL-1644-02

Using Cluster Manager to Upgrade One or More Switches g



| Upgrading the Switch Software

Using the CLI to Upgrade a Catalyst 2950 Switch

Step 1

Step 2

Step 3

Step 4

Step 5

Step 6

Note

This procedure is for upgrading Catalyst 2950 switches by copying the .tar file to the switch. You copy
the files to the switch from a TFTP server and extract the files by entering the tar command, with these
results:

¢ Changes the name of the current image file to the name of the new file that you are copying and
replaces the old image file with the new one. Perform this step only if you have space available on
your switch.

e Disables access to the HTML pages and deletes the existing HTML files before the software upgrade
to avoid a conflict if users access the web pages during the software upgrade.

e Reenables access to the HTML pages after the upgrade is complete.
Follow these steps to upgrade the switch software by using a TFTP transfer:

If your PC or workstation cannot act as a TFTP server, copy the file to a TFTP server to which you have
access.

Access the CLI by starting a Telnet session or by connecting to the switch console port through the
RS-232 connector.

To start a Telnet session on your PC or workstation, enter this command:

server$%$ telnet switch_ip address

Enter the Telnet password if you are prompted to do so.

Enter privileged EXEC mode:

switch> enable
switch#

Enter the password if you are prompted to do so.

Display the name of the running (default) image file (BOOT path-list). This example shows the name in
italic:

switch# show boot

BOOT path-list: flash: current_image
Config file: flash:config.text
Enable Break: 1

Manual Boot: no

HELPER path-list:
NVRAM/Config file
buffer size: 32768

If there is no software image defined in the BOOT path-list, enter dir flash: to display the contents of
Flash memory.

Using the exact, case-sensitive name of the .tar file that you downloaded, rename the running image file
to that name, and replace the .tar extension with .bin. The image filename is then the same as the
downloaded filename but with a .bin extension. This step does not affect the operation of the switch.

Perform this step only if you have space available on your switch and want to retain a copy of the old
image.

Using the CLI to Upgrade a Catalyst 2950 Switch
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Step 7

Step 8

Step 9

Note
Step 10

Step 11

A

Upgrading the Switch Software

switch# rename flash:current_image f£lash:new_image
Source filename [current_imagel?
Destination filename [new_image]?

For example:

switch# rename flash:c2950-i6qg412-mz.121-6.EA2.bin flash:c2950-i16g412-mz.121-6.EA2a.bin

Display the contents of Flash memory to verify the renaming of the file:

switch# dir flash:

Directory of flash:/

3 drwx 10176 Mar 01 2001 00:04:34 html
6 -rwx 2343 Mar 01 2001 03:18:16 config.text

171 -rwx 1667997 Mar 01 2001 00:02:39 ¢2950-16g412-mz.121-6.EA2a.bin
7 -rwx 3060 Mar 01 2001 00:14:20 wvlan.dat

172  -rwx 100 Mar 01 2001 00:02:54 env_vars

7741440 bytes total (4788224 bytes free)

Enter global configuration mode:

switch# configure terminal
Enter configuration commands, one per line. End with CNTL/Z.

Enter the boot command with the name of the new image filename:

switch(config)# boot system flash:new_ image

For example:

switch(config)# boot system flash:c2950-i6g4l2-mz.121-6.EA2a.bin

If the show boot command entered in Step 4 displays no image name, you do not need to enter this
command; the switch automatically finds the correct file to use when it resets.

Return to privileged EXEC mode:

switch(config)# end

Remove the HTML files:

switch# delete flash:html/*

Press Enter to confirm the deletion of each file. Do not press any other keys during this process.

Caution

Step 12

In this step, the tar command copies the .tar file that contains both the image and the HTML files.

Enter this command to copy the new image and HTML files to Flash memory:

switch# tar /x tftp://server ip address//path/filename.tar flash:
Loading /path/filename.tar from server_ip_address (via VLAN1):!)
extracting info (110 bytes)

html/ (directory)

extracting html/Detective.html.gz (1139 bytes)!
extracting html/ieGraph.html.gz (553 bytes)
extracting html/DrawGraph.html.gz (787 bytes)
extracting html/GraphFrame.html.gz (802 bytes)!
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Note

Step 13

Step 14

Step 15

Step 16

Depending on the TFTP server being used, you might need to enter only one slash (/) after the
server_ip_address in the tar command.

After you upgrade your switch to Cisco IOS Release 12.1(6)EA2 or later, the tar command is replaced
by the archive tar command.

Enter global configuration mode:

switch# configure terminal
Enter configuration commands, one per line. End with CNTL/Z.

Return to privileged EXEC mode:

switch(config)# end

Reload the new software with this command:

switch# reload
System configuration has been modified. Save? [yes/nol:y
Proceed with reload? [confirm]

Press Return to confirm the reload.
Your Telnet session ends when the switch resets.

After the switch reboots, use Telnet to return to the switch, and enter the show version user EXEC
command to verify the upgrade procedure. If you have a previously opened browser session to the
upgraded switch, close the browser, and start it again to ensure that you are using the latest HTML files.

Using the CLI to Upgrade Member Switches

Because a member switch might not be assigned an IP address, command-line software upgrades through
TFTP are managed through the command switch.

This section provides these procedures:

e “Upgrading Catalyst 2950, Catalyst 2900 XL or Catalyst 3500 XL Member Switches” section on
page 32

e “Upgrading Catalyst 1900 or Catalyst 2820 Member Switches” section on page 34

Upgrading Catalyst 2950, Catalyst 2900 XL or Catalyst 3500 XL Member Switches

Step 1

Step 2

Follow these steps to upgrade the software on a member switch:

In privileged EXEC mode on the command switch, display information about the cluster members:
switch# show cluster members

From the output, select the number of the member switch that you want to upgrade. The member number
is in the SN column of the display. You need this member number for Step 2.

Log in to the member switch (for example, member number 1):

switch# rcommand 1

Using the CLI to Upgrade Member Switches



Step 3

Step 4

Step 5

Step 6

Note

Step 7

Step 8

Step 9

Upgrading the Switch Software ||

Enter privileged EXEC mode:

switch> enable
switch#

Enter the password if you are prompted to do so.

Display the name of the running (default) image file (BOOT path-list). This example shows the name in
italic:

switch# show boot

BOOT path-list: flash: current_image
Config file: flash:config.text
Enable Break: 1

Manual Boot: no

HELPER path-list:
NVRAM/Config file
buffer size: 32768

If there is no software image defined in the BOOT path-list, enter dir flash: to display the contents of
Flash memory.

Using the exact, case-sensitive name of the .tar file that you downloaded, rename the running image file
to that name, and replace the .tar extension with .bin. The image filename is then the same as the
downloaded filename but with a .bin extension. This step does not affect the operation of the switch.

Perform this step only if you have space available on your switch and want to retain a copy of the old
image.

switch# rename flash:current_image f£lash:new_image
Source filename [current_imagel]?
Destination filename [new_image]?

For example:

switch# rename flash:c2950-i6qg412-mz.121-6.EA2.bin flash:c2950-i16g412-mz.121-6.EA2a.bin

Display the contents of Flash memory to verify the renaming of the file:

switch# dir flash:

Directory of flash:/

3 drwx 10176 Mar 01 2001 00:04:34 html
6 -rwx 2343 Mar 01 2001 03:18:16 config.text

171 -rwx 1667997 Mar 01 2001 00:02:39 ¢2950-i6g412-mz.121-6.EA2a.bin
7 -rwx 3060 Mar 01 2001 00:14:20 wvlan.dat

172  -rwx 100 Mar 01 2001 00:02:54 env_vars

7741440 bytes total (4788224 bytes free)

Enter global configuration mode:

switch# configure terminal
Enter configuration commands, one per line. End with CNTL/Z.

Enter the boot command with the name of the new image filename:

switch(config)# boot system flash:new_ image

For example:

switch(config)# boot system flash:c2950-i6g4l2-mz.121-6.EA2a.bin
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Note

Step 10

Step 11

A

If the show boot command entered in Step 4 displays no image name, you do not need to enter this
command; the switch automatically finds the correct file to use when it resets.

Return to privileged EXEC mode:

switch(config)# end

Remove the HTML files:

switch# delete flash:html/*

Press Enter to confirm the deletion of each file. Do not press any other keys during this process.

Caution

Step 12

Step 13

Step 14

Step 15

In this step, the tar command copies the .tar file that contains both the image and the HTML files.

Start the TFTP copy function as if you were initiating it from the command switch.

switch-1# tar /x tftp://server ip address//path/filename.tar flash:
Source IP address or hostname [server_ ip address]?

Source filename [path/filename]?

Destination filename [flash:new_image]?

Loading /path/filename.bin from server ip address (vial)

[OK - 843975 bytes]

Enter global configuration mode:

switch# configure terminal
Enter configuration commands, one per line. End with CNTL/Z.

Return to privileged EXEC mode:

switch(config)# end

Reload the new software with this command:

switch-1# reload
System configuration has been modified. Save? [yes/nol:y
Proceed with reload? [confirm]

Press Enter to start the download.

You lose contact with the switch while it reloads the software. For more information on the rcommand
command, refer to the Catalyst 2950 Desktop Switch Command Reference.

Upgrading Catalyst 1900 or Catalyst 2820 Member Switches

Step 1

Follow these steps to upgrade the software on a Catalyst 1900 or Catalyst 2820 member switch:

In privileged EXEC mode on the command switch, display information about the cluster members:

switch# show cluster members

From the display, select the number of the member switch that you want to upgrade. The member number
is in the SN column of the display. You need this member number for Step 2.

Using the CLI to Upgrade Member Switches



Step 2

Step 3

Step 4

Related Documentation 1l

Log in to the member switch (for example, member number 1):

switch# rcommand 1

For switches running standard edition software, enter the password (if prompted), access the Firmware
Configuration menu from the menu console, and perform the upgrade. Follow the instructions in the
installation and configuration guide that shipped with your switch. When the download is complete, the
switch resets and begins using the new software.

The Telnet session accesses the menu console (the menu-driven interface) if the command switch
password is privilege level 15. If the command switch password is privilege level 1, you are prompted
for the password.

You lose contact with the switch while it reloads the software.

For switches running Enterprise Edition Software, start the TFTP copy as if you were initiating it from
the member switch:

switch-1# copy tftp: //host/src_ﬁle opcode
For example, copy tftp://spaniel/op.bin opcode downloads new system operational code op.bin from
the host spaniel.

You should see the TFTP successfully downloaded operational code message. When the download is
complete, the switch resets and begins using the new software. If this message does not appear, refer to
the installation and configuration guide that shipped with your switch for more information.

You can also upgrade the switch software through the Firmware Configuration menu from the menu
console. For more information, refer to the installation and configuration guide that shipped with your
switch.

You lose contact with the switch while it reloads the software.

Related Documentation

These documents provide complete information about the switch and are available from this Cisco.com
site:

http://www.cisco.com/univercd/cc/td/doc/product/lan/cat2950/index.htm

The software documents are not shipped with the product, but you can access them under the appropriate
I0S software release on Cisco.com. You can order printed copies of documents with a DOC-xxxxxx=
number from the Cisco.com sites and from the telephone numbers listed in the “Ordering
Documentation” section on page 36.

These publications provide more information about the switches:
e The Catalyst 2950 Desktop Switch Software Configuration Guide (order number DOC-7811380=)
e The Catalyst 2950 Desktop Switch Command Reference (order number DOC-7811381=)
e The Catalyst 2950 Desktop Switch Hardware Installation Guide (order number DOC-7811157=)
e Catalyst GigaStack Gigabit Interface Converter Hardware Installation Guide (DOC-786460=)
¢ (Cluster Management Suite (CMS) online help

| oL-1644-02

Related Documentation ]


http://www.cisco.com/univercd/cc/td/doc/product/lan/c3550/index.htm

I Obtaining Documentation

Obtaining Documentation

The following sections provide sources for obtaining documentation from Cisco Systems.

World Wide Web

You can access the most current Cisco documentation on the World Wide Web at the following sites:
e http://www.cisco.com
e http://www-china.cisco.com

e http://www-europe.cisco.com

Documentation CD-ROM

Cisco documentation and additional literature are available in a CD-ROM package, which ships
with your product. The Documentation CD-ROM is updated monthly and may be more current than
printed documentation. The CD-ROM package is available as a single unit or as an annual subscription.

Ordering Documentation

Cisco documentation is available in the following ways:

e Registered Cisco Direct Customers can order Cisco Product documentation from the Networking
Products MarketPlace:

http://www.cisco.com/cgi-bin/order/order_root.pl

e Registered Cisco.com users can order the Documentation CD-ROM through the online Subscription
Store:

http://www.cisco.com/go/subscription

e Nonregistered Cisco.com users can order documentation through a local account representative by
calling Cisco corporate headquarters (California, USA) at 408 526-7208 or, in North America, by
calling 800 553-NETS(6387).

Documentation Feedback

If you are reading Cisco product documentation on the World Wide Web, you can submit technical
comments electronically. Click Feedback in the toolbar and select Documentation. After you complete
the form, click Submit to send it to Cisco.

You can e-mail your comments to bug-doc @cisco.com.

Obtaining Documentation
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To submit your comments by mail, use the response card behind the front cover of your document, or
write to the following address:

Attn Document Resource Connection
Cisco Systems, Inc.

170 West Tasman Drive

San Jose, CA 95134-9883

We appreciate your comments.

Obtaining Technical Assistance

Cisco provides Cisco.com as a starting point for all technical assistance. Customers and partners can
obtain documentation, troubleshooting tips, and sample configurations from online tools. For Cisco.com
registered users, additional troubleshooting tools are available from the TAC website.

Cisco.com

Cisco.com is the foundation of a suite of interactive, networked services that provides immediate, open
access to Cisco information and resources at anytime, from anywhere in the world. This highly
integrated Internet application is a powerful, easy-to-use tool for doing business with Cisco.

Cisco.com provides a broad range of features and services to help customers and partners streamline
business processes and improve productivity. Through Cisco.com, you can find information about Cisco
and our networking solutions, services, and programs. In addition, you can resolve technical issues with
online technical support, download and test software packages, and order Cisco learning materials and
merchandise. Valuable online skill assessment, training, and certification programs are also available.

Customers and partners can self-register on Cisco.com to obtain additional personalized information and
services. Registered users can order products, check on the status of an order, access technical support,
and view benefits specific to their relationships with Cisco.

To access Cisco.com, go to the following website:

http://www.cisco.com

Technical Assistance Center

The Cisco TAC website is available to all customers who need technical assistance with a Cisco product
or technology that is under warranty or covered by a maintenance contract.

Obtaining Technical Assistance
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Contacting TAC by Using the Cisco TAC Website

If you have a priority level 3 (P3) or priority level 4 (P4) problem, contact TAC by going to the TAC
website:

http://www.cisco.com/tac
P3 and P4 level problems are defined as follows:

e P3—Your network performance is degraded. Network functionality is noticeably impaired, but most
business operations continue.

¢ P4—You need information or assistance on Cisco product capabilities, product installation, or basic
product configuration.

In each of the above cases, use the Cisco TAC website to quickly find answers to your questions.
To register for Cisco.com, go to the following website:
http://www.cisco.com/register/

If you cannot resolve your technical issue by using the TAC online resources, Cisco.com registered users
can open a case online by using the TAC Case Open tool at the following website:

http://www.cisco.com/tac/caseopen

Contacting TAC by Telephone

If you have a priority level 1 (P1) or priority level 2 (P2) problem, contact TAC by telephone and
immediately open a case. To obtain a directory of toll-free numbers for your country, go to the following
website:

http://www.cisco.com/warp/public/687/Directory/DirTAC.shtml
P1 and P2 level problems are defined as follows:

e Pl—Your production network is down, causing a critical impact to business operations if service is
not restored quickly. No workaround is available.

e P2—Your production network is severely degraded, affecting significant aspects of your business
operations. No workaround is available.

This document is to be used in conjunction with the documents listed in the “Related Documentation” section.

Copyright © 2002, Cisco Systems, Inc.
All rights reserved.
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